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5. Agro-meteorology and Hydrology 

Objectives of the module

Having completed this exercise you will be able to: 
Generate missing rainfall data given historical data of a station 
Establish the rainfall – runoff relationships for selected sites 

Requirements for the module 

Computer with Microsoft Windows Operating Systems (Windows
98, 2000, XP) 
Spreadsheet and word processing packages (Microsoft Excel and

Microsoft Word) 
PARCHED – THIRST Model (Version 2.3) 
35 years weather data for a Met Station eg. Morogoro 
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5.1 Formation of Precipitation

Moisture is always present in the atmosphere, even on cloudless days. For precipitation to 
occur, some mechanism is required to cool the air sufficiently to bring it to or near saturation.
The large scale cooling needed for significant amounts of precipitation is achieved by lifting 
the air. This is accomplished by convective systems resulting from unequal radiative heating
or cooling of the earth's surface and atmosphere or by convergence caused by orographic 
barriers. Saturation, however, does not necessarily lead to precipitation.

5.1.1 Measurement of Rainfall

All forms of precipitation are measured on the basis of the vertical depth of water that would 
accumulate on a level surface if the precipitation remained where it fell. In the metric system, 
precipitation is measured in millimeters. The instrument commonly used is the rain gage.

5.1.2 Precipitation - gage network

The spatial variability of precipitation and intended uses of the data should determine network 
density. Relatively sparse network of stations would suffice for studies of 1arge general 
storms or for determining annual averages over large areas of level terrain. A very dense 
network is required to determine the rainfall pattern in thunderstorms. The probability that a 
storm center will be recorded by a gage varies with network density. A network should be 
planned to yield a representative picture of the area distribution of precipitation. On the other 
hand, the cost of installing and maintaining a network and accessibility of the gage site to an 
observer are always important considerations.

5.1.3 The analysis and presentation of rainfall data 

Hydrologists' interest in precipitation data relates to engineering design; water supply and 
river forecasting, watershed management and research. The data are usually subjected to 
analysis of frequency characteristics, extremes, regression and physical relationships. Some of
the methods and problems relating to data interpretation and processing are discussed in this 
section.

5.1.4 Climatological records

The quality and completeness of records should be considered in analysis. Homogeneous, 
complete series are required for many studies, but are not always available. The observer, the 
location and exposure of instrument, the type and shielding of instruments may change from
time to time, thereby necessitating checks on homogeneity. Observational errors are probably 
less common in current publications, because of present quality control methods. However,
historic data may require close scrutiny and adjustment.

5.1.5 Estimating missing data 

Missing rainfall data may be estimated from values measured at about three other locations or 
index stations, near and evenly spaced around the station with the missing record. If the 
normal annual rainfall at each of the index stations is within 10 percent of that for the station
with the missing record, a simple arithmetic average provides an estimate.
If the normal annual rainfall at any of the index stations differs from that at the station in
question by more than 10 percent, the Normal Ratio Method is used. In this method, the
amounts at the index stations are weighted by the ratios of the normal annual precipitation 
values. That is, rainfall Px at station X is 
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Where
Px = Rainfall of the station with missing data 
PA, PB, PC = Rainfall at the index stations 
NA, NB, NC = Normal annual precipitation at the index stations 

Multiple linear regressions will yield an equation of the form

CCBBAAX PbPbPbaP (3)

Where a should be near zero and the bs' will approximate the three coefficients of Equation
(1) divided by 3. The advantage of the regression approach is that it allows for some
weighting of the stations and adjusts, to some extent, for departures from the normal ratio 
assumption of Equation (1). 
If a large amount of data must be estimated, random error term should be added to the 
equation. In this term, t is normal random number with mean of zero and standard deviation. 
of 1, and Sy is the standard error of estimate of Px. Inclusion of the term recognises the 
departures from the regression and maintains the standard deviation of the estimated values of
Px near the observed standard deviation. 

5.2 PARCHED-THIRST Climate Generator

If sufficient historical data are not available, the PARCHED-THIRST Climate Generator can 
be used to generate weather variables at a site when only rainfall data are available, and if
there are periods of missing data in weather records, it can be used to ‘fill in’ the gaps.
The PARCHED-THIRST Climate Generator works by extracting the statistical properties of 
historical weather data and using these, in combination with random number generators to 
produce novel series of weather data with the same statistical properties as that which was 
input. It is important to realise that it is in no way a weather forecasting tool and that the 
weather it generates takes no account of long-term climate change. 

5.2.1 Input

The model obtains the necessary statistical parameters from one of the following three ways: 
Historical data - as with any statistical method, the larger the sample (i.e. the number
of years of weather data at a site), the better will it represent the population from
which it is taken (i.e. the long-term weather at that site). 
Default weather parameter files - the PARCHED-THIRST Climate Generator is 
supplied with weather parameter files for a number of sites in Tanzania. 
User-defined weather parameter files - these can be created from historical data. In 
future, it will be possible to use the monthly averages of rainfall, temperature, etc. to 
generate daily weather (albeit with limited reliability) but this capability is still being
developed.
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5.2.2 Output

It can generate two different types of weather data depending upon the data available: 
Full agro meteorological weather files - this is the generation of the full range of 
variables required by PT software. 
Rainfall dependent weather files - in many areas, rainfall data have been collected for 
long periods of time while other agro-meteorological data have only been recorded in 
recent years. To allow the full potential of these long-term rainfall records to be
realised, the Climate Generator can use the statistical properties of the recent agro-
meteorological data to realistically generate the rest of the weather variables in the
years for which only rainfall data are available. 

5.3 Rainfall – Runoff Relationship 

5.3.1 Surface runoff phenomena 

Depending, upon the rate at which rain falls, water may either infiltrate into the soil or 
accumulate and flow from an area as surface runoff. If the intensity of rainfall is less than the 
rate of infiltration, all water will enter the soil profile. Conversely, when the intensity of 
rainfall is greater than the rate of infiltration, a sequence of events occur which ultimately will 
produce surface runoff. 
Excess water produced by a high intensity of rainfall must first satisfy soil and vegetal 
storage, detention and interception requirements. When the surface depressions are filled,
surface water then begins to move down the slopes in thin films and tiny streams. When the 
rain is particularly intense and prolonged, or both, the surplus runoff becomes large and the 
stream and river channels cannot accept all the water suddenly arriving. They become filled
and overflow causing flooding and damage to property. The disposition of storm rainfall is 
shown in Figure 5.1. 

Figure 5.1. The hydrological components of a conceptual rainwater harvesting system 
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5.3.2 Catchment characteristics and their effect on runoff 

Catchment area 
The topographic water divide usually, but not necessarily bound the catchment area. Because 
of the underlying geology, it is perfectly possible for areas beyond the divide to contribute to 
a catchment.

Main stream length 
This is measured in kilometres from the gauging station or catchment outfall. When
measuring from maps it is normal to use a standard routine to remove subjectivity (e.g. set
dividers at 0.1 km on a 1:25000 scale map)

a) Slope of Catchment
The more the steepness of the ground surface the more rapidly will surface runoff travel. Also
both the time of concentration and time to peak will be short. Infiltration capacities tend to be 
lower as slopes get steeper; since vegetation is less dense and soil more easily eroded, thus 
accentuating runoff. 

b) Catchment orientation
Orientation is important with respect to meteorology of the area in which the catchment lies. 
If the prevailing wind and lines of storm movements have a particular seasonal pattern, as
they usually have, the runoff hydrograph will depend to some degree on the catchment
orientation within the pattern.

Climatic factors
The main effect of climate is in rainfall intensity and duration. Rainfall intensity has a direct 
bearing on runoff since once the infiltration capacity of the soil is exceeded; all the excess
rain is available and flows to the surface water courses.

5.3.3 Rainfall – Runoff correlation

While there is a general cause – and -effect relationship between rainfall and the resulting
runoff, it is not a direct one. By the time evaporation, interception, depression storage, 
infiltration and soil moisture deficiency are taken into account and the resulting residual 
rainfall at various intensity applied to catchments that vary in size, slope, shape, altitude, 
subsurface geology and climate, the relationship must include extreme values that defy 
rational correlation, at least in the short time.
Notwithstanding the foregoing, it may be possible to establish an empirical relationship for 
particular catchment based on annual precipitation and runoff. To do this it is a 12 - month
period starting and finishing at the time of seasonal minimum flow. If precipitation and runoff 
are plotted against each other as catchment depths, a correlation like the one shown in Figure 
5.2 is obtained. 
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Figure 5.2. Rainfall – Runoff Correlation 

In many tropic and humid climates, a straight-line relationship is generally found i.e. 

x
y
P

R
(4)

Where P = annual precipitation
R = annual runoff 
x and y are as shown in Figure 5.2 

5.4 PT Model Software

PARCHED THIRST is an acronym for Predicting Arable Resource Capture in Hostile 
Environment During The Harvesting of Incident Rainfall in Semi Arid Tropics. The model
was developed to simulate the rainwater harvesting system in semi arid tropics. It simulates
the runoff process, soil-water movement and the crop growth and yield in response to daily 
climatic data. It is a process-based model with a user-friendly interface. PARCHED-THIRST
(PT) is a lumped parameter model where the landscape is divided into units of land assumed
to be homogeneous landscape; this is referred to as profile in the model. The collection of 
these profiles forms a system, which can either, be rainfed or rainwater harvesting depending 
on the number of profiles.  Rainwater harvesting system is represented by more than one 
profiles where one or more profiles represent the runoff generation areas and the other
represent the runoff receiving area and the only transferable mass between these profiles is the
surface runoff.
At the system level the inputs to the model are weather variables (Rainfall, Evaporation, 
Maximum and Minimum temperature, Relative humidity, Wind speed and Radiation). Other 
inputs at the system level include location and latitude. Criteria for sowing (timing) are 
entered at the system level, these can be user defined or predicted by model. In case of user 
defined, the input is the date of sowing for a particular season. The number of years of 
simulation is entered at the system level together with start date of the season and number of 
seasons to be simulated.
The inputs at the profile level are crops, weeds, soil properties and soil surface characteristics.
Soil properties inputs to the model include soil layer depth and initial soil moisture content for 
each layer, soil type (texture), soil fertility equilibrium rate, soil strength which determines the
resistance of soil to root growth, soil drainage parameter which determines rate at which water 
drains out of the soil profile and macro pores distribution and flow rate. Soil surface
parameters inputs are bund height if storage is allowed, percentage of soil evaporation 
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reduction if there is any surface treatment like crop cover, and mulching, area represented by
the profile and slope of the profile. 
Given all these input, the PT model is capable of simulating crop yield. Other parameters that 
can be found in the simulation output summary file include Surface Runoff, 
Evapotranspiration, dry matter accumulation and grain weight gain. 
The PT Model will be used in the following two (2) exercises. The first exercise involves the 
generation of missing climatic data given historical data of the same station. The second 
exercise seeks to establish the rainfall/runoff relationship from simulation output file. 

5.4.1 Exercise 1: Generating Missing Rainfall Data 

Step One: Starting the PT Model and accessing the climatic generator 
Double-click on the PTv2.3 model icon or from the Start task bar go to Programs and 
from the program list click PTv2.3. The PTv2.3 main window and Welcome screen 
will appear as shown in Figure 5.3. 

Figure 5.3. Welcome screen of the PT Model 

On the Welcome screen click on the icon Experienced User to be taken straight to the 
main system window of PTv2.3 as shown on Figure 5.4. 
On the menu bar click on Tools and from the Tools submenu select and click Climate
Generator. The Climate Generator main window will appear as in Figure 5.5.
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Figure 5.4. PT Model Main window 

Figure 5.5. Climate Generate Main Window

Step two: Specify the input data file 
On the Climate Generator menu, click on the word Input and a drop-down menu will 
appear.
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Figure 5.6. Climate Generator input window 

Click the Historical item on the drop down menu to indicate that the parameter source 
will be our historical data file. The Parameter File Window will then appear as shown 
in Figure 5.6. 
Under File Type, choose the option button labelled *.DAT to indicate that our file 
names end in. DAT. A list of files of this type will appear in the left hand box.
Under Location Code (within Weather Station Location), choose the option button 
labelled Other… The text box after the Four-letter abbreviation will be active. Type 
CGEN in this textbox.. 
Under Years of Data Available, click on the arrows to change the First year to 1971 
and the Last year to 1980. The names of the first and last files should now be shown in 
blue in the two textboxes (Labelled First and Last) at the top of the window.
Under Permit data choose the Correct option. 
Click OK to return to the Climate Generator window.

We have indicated the source of the data. Now we need to tell the programme how much data 
to generate and where to store these data. 

Step Three: Specify Output File Settings 
On the Climate Generator window menu click on Output.
On the output sub menu click on Evaporation. The Evaporation data window similar
to Figure 5.7 will appear.
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Figure 5.7. Evaporation data window 

Set Latitude to –6 and Altitude to 520m (Morogoro). Click OK to go back to the
Climate Generator main window.
Select Output from the window menu and on the output sub menu click on Create 
parameter file… to open the Create a weather parameter file… window as shown in 
Figure 5.8. 

Figure 5.8. Weather parameter file 

Under Weather Parameter File Name, change whatever in the textbox to 
C:\PROGRAM FILES\PTV23\weather\generated\CGEN.GEP.
Under Parameter type check Daily option button and click OK. You will be taken back
to the Climate Generator input window you completed in Step two.
Verify the Climate Generator input window to check if the parameters you specified in 
step two were not altered.
Rectify any changes if any and click OK. 
A Data input error message box will appear as shown in Figure 5.9 below. 

Figure 5.9. Data Input Error
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Click OK to continue. You will see a series of progress bars similar to that of figure
5.10.

Figure 5.10. Progress Bar 

Wait until another message appears (Figure 5.11), indicating the location where the 
.GEP file is saved. Click OK to return to the Climate generator main window. 

Figure 5.11. Location of the parameter file 

Step Four: Specify the Output File Location 
From the Climate generator menu, select output and click files.. the simulation Option 
window similar to that of Figure 5.12 will appear. 

Figure 5.12. Climate Generator output window using Historical *.DAT Files 

Under file type and location choose *.WEA
Browse to the folder C:\Program files\PT v2.3\Weather\Generated\ as shown in Figure 
5.13. That is where the generated data files will be stored. 

PT Model Help Office
Sokoine University of Agriculture 72



Chapter 5 
Agro-meteorology and Hydrology

Figure 5.13. Location of the output data files 

Under Output Data, choose PTv2 input option. 
Under Location Code check the other button and type CGEN in the Four-letter
abbreviation text box. 
Under Years to be Generated, change First Year to 1971 and No of years to 10.  The 
output file window should then appear as shown in Figure 5.14 below. 

Figure 5.14. Climate Generator output window (with all settings) 

Click OK to return to the Climate Generator window. Now we can run the Climate
Generator to produce the data. 

Step Five: Running the Climate Generator 
Click on the word File on the Menu bar and select save from the drop-down menu. In 
the File name textbox, type Moro 1971_1980.GEN as shown in Figure 5.15. 
Click on Save to continue. 
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Figure 5.15. Saving the Climate generator file 

Now we can run the Climate Generator to produce the data. However, it would be nice to see 
a comparison between the data we have input and the data the model is going to generate. To 
achieve it check Produce Summary check box on the Climate Generator window (under 
GENERATION SUMMARY).

Finally, go to the File drop-down menu and select RUN. You will see the data input 
error of Figure 5.16. Click OK to continue. 
A status box (Figure 5.17) indicates the progress. At the end of the simulation, you 
will be asked whether you wish to see a comparison of observed and generated data. 
Answer Yes and the Generation Summary Window of Figure 5.18 will appear.

Figure 5.16. Data Input error 

Figure 5.17. Progress bar 

PT Model Help Office
Sokoine University of Agriculture 74



Chapter 5 
Agro-meteorology and Hydrology

By clicking on the buttons to the right (Say Rainfall), and the option buttons at the bottom of 
the window (Mean monthly daily rainfall (mm), you can see a comparison of various aspects 
of the historical and simulated data as shown in Figure 5.18. 

Figure 5.18. Generation summaries

When you have finished press Exit. You will then be asked whether you wish to 
generate more data. Answer No and you will be returned to the Main Window.

You have now generated 10 years of data for Morogoro Station including 1977 data, which 
was missing.

Step Six: Accessing the generated rainfall data 
The synthetic data generated were saved in C:\Program files\PT v2.3\Weather\Generated\
with names CGENW71.WEA, CGENW72.WEA, … and CGENW80.WEA. They are then in 
.WEA format and they can be opened with Microsoft Excel.

Open Microsoft Excel 
From the File menu click Open or click on the Open toolbar. Go to the folder 
C:\Program files\PT v2.3\Weather\Generated\ and in the Files of type list box, select 
All files (*.*) as shown in Figure 5.19. 
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Figure 5.19. Open file window 

Select the file CGENW77.WEA and click the on Open. You will see a Text Import
Wizard window similar to that of figure 5.20. 

Figure 5.20. Text Import Wizard - Step 1 of 3

Select the Delimited option and click next. 
On the next Text import Wizard - step 2 of 3, check the Comma Check Box and click
Finish to view the generated data. 

The data are arranged in columns (365 or 366 rows for leap years) in the following order: 
Null, Null, Rain(mm), Evap(mm), MaxT(C), MinT(C), Null, Null, Null, SatDef(kPa),
Radn(MJ/m2), RelHum(%), Wind(km/d);  i.e. the rainfall data is displayed in column C 
which is highlighted in Figure 5.21 below. 

To open other generated files, follow the same procedure. Also, to open the .DAT files 
used to generate data the same procedure applies except that On the Text import
Wizard - Step 2 of 3window you should check the Space Check Box instead of the 
Comma Check box. 
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Figure 5.21. Generated data file (CGENW77.WEA) opened with MS Excel. 

5.4.2 Assignment

Open the synthetic generated data files and copy the rainfall columns for every year 
into a new Excel workbook. Calculate the mean daily and the mean monthly rainfall. 
Open the original data files (.DAT) files used to generate data and copy the rainfall 
columns (without column headings) into another sheet on the same workbook. 
Calculate the mean daily rainfall and the mean monthly rainfall. 
Plot generated mean daily rainfall and actual mean daily rainfall (January to April) and 
February in one chart and comment on your results. You graph should be similar to 
that shown in Figure 5.22. 
Plot also means monthly rainfall. 
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Figure 5.22. Actual Vs Generated Daily Rainfall 

5.4.3 Exercise 2: Investigating Runoff Generation 

Step One: Starting the PT Model
Double-click on the PTv2.3 model icon or from the Start task bar go to Programs and 
from the program list click PTv2.3.  The PTv2.3 main window and Welcome screen
will appear.
On the Welcome screen click on the icon experienced user to be taken straight to the 
main system window of PTv2.3.
Go to the Systems menu and select Open. Select the file “Rainfall Runoff VLAB” and 
click open. 

Step two: Specify System
On the main windowpane select System and click on Properties to open the System
Properties window of Figure 5.23. 

PT Model Help Office
Sokoine University of Agriculture 78



Chapter 5 
Agro-meteorology and Hydrology

Figure 5.23. System properties window 

Set the following properties as follows:
Timing (Click on the Timing button) 

Number of years: 35 
Number of seasons: 1 per annum
Season start date: 1st January 1971 

Sowing (Click on the Sowing button) 
Sowing decision: Defined 
Sowing date: 1st March 

Site (Click on the Site button) 
Location: Morogoro 
Latitude: -6

Weather (Click on the Weather button) 
File stem: morx 
File type: Standard 

Click OK to continue 

Step three: Specify profile settings
Double click on the profile 1 icon or, right click on profile 1 and select Properties of profile 
(See Figure 5.24). You will be taken to the profile properties window of Figure 5.25.

Figure 5.24. Opening the profile properties window 
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Figure 5.25.  Profile 1 Properties window 

Click on Soil surface option to verify the following settings: 
Surface storage: The Area is bunded and the Release ponded water checkboxes 
should remain unchecked. 
Surface characteristics: Impervious area: 0% 
    Reduce Soil Evaporation by: 0%
Topography: Area represented by profile: 0.5 ha 

Slope of area: 45% 
Click on OK to continue 

Step Four: Running Simulation
Go to the system menu and click on Save.
Go again to the system menu and click on RUN. You will be prompted to specify
simulation summary and daily output file name as shown in Figure 5.26. 
Name the simulation summary file as RainfallRunoffSumary and the simulation daily 
output file as RainfallRunoffDaily. 
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Figure 5.26. Saving Simulation summary

On the see simulation graphics? Dialogue box click on Yes (Figure 5.27) to view 
simulation graphics. 
Under Speed of simulation (Figure 5.28) select Fast
Click OK to continue. You will see simulation graphics of Figure 5.29 below. 

Figure 5.27 . Simulation graphics 
dialogue

Figure 5.28 . Simulation Speed dialogue 

Wait until you see the message “End of Simulation.” Click OK to view the simulation
output summary graphs of Figure 5.30 below.
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Figure 5.29. Simulation graphics window 

The window shows the total seasonal rainfall for all 35 years simulated. To view other 
parameters (Runoff, Yield, ET, Evaporation, Drainage), click on the corresponding option 
buttons on the left of the summary graphs. 

Figure 5.30. Simulation output summary window 

You have now run 35 years simulation. Let’s go to the output file to view the results of our
simulations.
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Step Five: Accessing the Output File 
Minimize or Close the PT Model window and start Microsoft Excel. Go to the File
menu and click on open (or click on the open toolbar).
Look for the folder c:\Program files\PTv23\output\. In the files of type text box select
All files (as you did in step 6 - Exercise 1). Choose the file “RainfallRunoffSummary”
and click on Open.. You will see the simulation output summary as shown in Figure 
5.31.

Figure 5.31. Output summary file 

5.4.4 Assignment

Open a new blank Excel workbook and save it as RainfallRunoffCorrelation on the 
desktop.
Copy columns A (YearsNo), K(Srain) and F(Runoff), from RainfallRunoffSummary
file and paste them into sheet 1 of the RainfallRunoffCorrelation file you created. 
Draw The Rainfall Runoff Correlation graph (Use the XY scatter option and add a 
trend line to the plot) as shown in Figure 5.32. 
Deduce an equation of the form

x
y
P

R
(5)

Where P = annual precipitation 
   R = annual runoff

x and y are The intercepts

Comment on your results. 
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Figure 5.32. Rainfall-runoff correlation 
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